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Eclipse IDE for ModusToolbox™

quick start guide
ModusToolbox™ tools package version 3.0.0

About this document

Scope and purpose

ModusToolbox™ software is a set of tools that support device configuration and application development.
These tools enable you to integrate our devices into your existing development methodology.

Intended audience

This guide provides a quick walkthrough for using the Eclipse IDE provided as part of the ModusToolbox™ tools
package. If you wish to use other IDEs, such as VS Code, IAR, or pVision, refer to the "Export to IDEs" chapter in
the ModusToolbox™ tools package user guide.

Document conventions

Convention Explanation

Bold Emphasizes heading levels, column headings, menus and sub-menus

Italics Denotes file names and paths.

Courier New Denotes APIs, functions, interrupt handlers, events, data types, error handlers, file/folder names,
directories, command line inputs, code snippets

File > New Indicates that a cascading sub-menu opens when you select a menu item

Reference documents

Refer to the following documents for more information as needed:

e ModusToolbox™ tools package installation guide - This provides information and instructions about
installing the tools package on Windows, Linux, and macOS.

e Eclipse IDE for ModusToolbox™ user guide - This provides more details about features added to the
ModusToolbox™ version of the Eclipse IDE.

e Eclipse IDE survival guide - This provides a FAQ about how to use Eclipse to perform common tasks.

e Eclipse Workbench User Guide - This provides more details about the generic Eclipse environment.

e ModusToolbox™ tools package user guide. - This provides information about all the tools included with
ModusToolbox™.

e Project Creator user guide - This provides specific information about the Project Creator tool.

e Device Configurator guide - This provides specific information about the Device Configurator.
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Download/Install/Run Eclipse IDE

1 Download/Install/Run Eclipse IDE

Refer to the instructions in the ModusToolbox™ tools package installation guide for how to download and
install ModusToolbox™ software, as well as how to run the Eclipse IDE. As noted in the guide, when you first run
the IDE, a dialog opens to specify the workspace.

{4 Eclipse IDE for ModusToolbox™ Launcher x

Select a directory as workspace

Eclipse IDE for ModusToolbox™ uses the workspace directory to store its preferences and development artifacts.

Workspace: 9 C:\Users\user\mtw{ ~ Browse...

[ Use this as the default and de not ask again

Then, accept the License Agreement, and the Eclipse IDE opens with the Quick Panel and Console by default.

EQu.. =Va. &Ex. %Br. = O

Eclipse IDE for

[ hw - Eclipse IDE for ModusToolbox™ - [m] X

File Edit Navigate Search Project Run Window Help

Tuld [ r@~ittvOvQvi®gvil: EXARS B oD G D |
Q el

=0 ZEQu.xr 0O

There is no active

editor that
ModusToolbox™ orcvides an
« Start outline.
& New Application
& Import Exist ng Application In-Place
& Search Online for Code Examoles
& Searc QUiCk BSPs
# Train
Panel
%, Refred
~ Project
~ Launches & Console 2 2! Problems @ Memory & Terminal = b B | = *O~=108
ModusToaolbox™ Console
~ Tools

session are stored at: C:\Users\VegaO\AppData\lLocal\Temp\lLogs185211195875620

~ BSP Configurators (<bsp-name=)

Console

e The Quick Panel provides links to tool commands and documentation.

e The Console displays various messages when updating the application in some way (building,

programming, etc.).
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Create new application

2 Create new application

Creating an application includes several steps, as follows:

2.1 Step 1: Open Project Creator tool

In the Quick Panel, click the New Application link.

Eou. ®-Va.. STEx. %Br. — O

Eclipse IDE for
ModusToolbox™

- Start

New Application

Import Existing Application In-Place

& search Online for Code Examples
& Search Online for Libraries and BSPs
& Training Material

& Refresh Quick Panel

» Project

¢ Launches

» Tools

» BSP Configurators (<bsp-name>)

Or, select File > New > ModusToolbox™ Application.

[ hw - Eclipse IDE for ModusToolbox™
File Edit MNavigate Sesrch Project Run Window Help
New Alt+Shift«N > [} Project...

Open file.. 9 Other.. Ctrl+N
[ Open Projects from File System...

Recent Files , | = _ModusToolbox™ Application _ Ctrl+7

The Eclipse IDE displays a message and waits for the Project Creator tool to open.

File Edit Navigate Search Project Run Window Help
o &8~ R - % -0 -G -i®y-iD EX 1T IR IR R R Q el
 Quic.. ©-=Vari.. % Exp.. ®sBrea. ~ O = 8 Z=outlinex T O
A
Eclipse IDE for There is no active
™ editor that provides an|
ModusToolbox ey
~ Start

& New Application
- Import Existing Application In-Place

& Search Online for Code Examples
Waiting for project creation.
& Search Online for Libraries and BS
. ‘When project creator and project import have completed, this dialog will close automatically.
& Training Material

| Refresh Quick Panel

» Project
» Launches
» Tools

» BSP Configurators (<bsp-name>)

& Console ¢ [ Problems @ Memory 4 Terminal BB #Bryir=0
ModusToolbox™ Console
Log file(s) for this session are stored at: C:\Users\VegaO\AppData\local\Temp\lLogs1@5211°
Opening project creator from C:/Users/VegaO/ModusToolbox/tools_3.8/project-creator/proje«

User Guide 30f13

Infineon

002-22555 Rev. *J
2022-09-27



o~ _.
Eclipse IDE for ModusToolbox™ |nf|ne0n
quick start guide
Create new application

2.2 Step 2: Choose Board Support Package (BSP)

When the Project Creator tool opens, expand one of the BSP categories under Kit Name and select an
appropriate kit; see the description for it on the right. For this example, select the CYSCKIT-062-WIFI-BT kit.
The following image is an example; the precise list of boards available in this version will reflect the platforms
available for development.

Choose Board Support Package (BSP) - Project Creator 2.0 — O X
Settings Help

Source Template

Enter filter text Browse... = CY8CKIT-062-WIFI-BT
Kit Name MCU/SOC/SIP Connectivity || The PSOC™ 6 WiFi-BT Pioneer Kit is a low-cost hardware platform that enables
AIROC™ Bluetooth® BSPs design and debug of the PSoC™ 62 MCU (CY8C6247BZI-D54) and the Murata
AIROC™ Connectivity BSPs LBEESKL1DX Module (CYW4343W WiFi + Bluetooth Combo Chip).
PMG1 BSPs 3
PSQC™ 4 BSPs Kit Features:
~ PSoC™ 6 BSPs ® BLE V5.0
CYBCEVAL-06252 CYBCH24ABZI-S2D44 <nonex * Serial memory interface
CYBCEVAL-06252-LAI-4373M2  CYBC624ABZI-52D44 CYW43T73EUBGT * PDM-PCM digital microphone interface
CYBCEVAL-06252-MUR-43439M2 CYBC624ABZI-52D44 CYW43439KUBG * Industry-leading CAPSENSE

*® Full-speed USB

CYBCKIT-062-BLE CYBC6H347BZ1-BLD53 <none>
CY8CKIT-06252-43012 CYBC624ABZI-52D44 CYW43012COWKWBG * IEEE 802.11a/b/g/n WLAN
CYBCKIT-06254 CY8CH244LQI1-54D32 <none> Kit Contents:
CY8CKIT-062-WIFI-BT CYBC6247BZ1-D54  CYW4343WKUBG
® CY8CKIT-062-WIFI-BT evaluation board
CYBCKIT-0648052-4343W CYBOGA4ABZI-52D44 CYWA3ASWKUBG ® TFT display shield with a 24" TFT display, light sensor, 6-axis motion
CY8CKIT-0645052-4343W CYSO644ABZI-52D44 CYW4343WKUBG sensor, and digital microphane
CYBCPROTO-062-4343W CYBC624ABZI-52D44 CYW4343WKUBG  USB cable
CYBCPROTO-06253-4343W CYBC6245LQ1-S3D72 CYW4343WKUBG
CY8CPROTO-063-BLE CYBLE-416045-02  <nonex
CY8CPROTO-064B0S1-BLE CYB06447BZI-BLDS53 <nonex
CYRCPROTO-NARARNST CYBNA4451 N1-S3042 <nnne hd
Finished loading the manifest data (3716 ms) (S
Loading the device db
INFO:No device-db assets found in manifest
0 error(s), 0 warning(s)
Summary:
BSP: CYSCKIT-062-WIFI-BT v
Next > Close
<3
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2.3 Step 3: Select application

Click Next > to open the Select Application page. This page displays example applications, which demonstrate
different features available on the selected BSP. In this case, the CYSCKIT-062-WIFI-BT provides the PSoC™ 62
MCU and the AIROC™ CYW4343W Wi-Fi & Bluetooth® combo chip. You can create examples for PSoC™ 6 MCU
resources such as CAPSENSE™ and QSPI, as well as numerous examples for other capabilities.

For this example, expand Getting Started and select Hello World from the list. This example exercises the
PSoC™ 6 MCU to blink an LED.

Select Application - Project Creator 2.0
Settings Help

Application(s) Root Path: | C;/Users/VegaO/mtw Browse.

Target IDE: Eclipse IDE for ModusToolbox™

Search. Browse.. ¢ = 2 [=] [ |This code example demonstrates simple UART communication by printing
a "Hello World" message on a terminal and blinks an LED using a Timer
resource using PSoC™ 6 MCU.

Template Application New Application Name
Bluetooth®
v Getting Started For more details, see the README on GitHub.
[] Dual-CPU Empty PSOC6 App
[] Empty PSoC6 App
Hello World
[ Security App
[ switching Power Modes
Graphics
Machine Learning
Manufacturing
Peripherals
Sensing
Voice
Wi-Fi

Summary:

BSP: CY8CKIT-062-WIFI-BT

Template Application(s): Hello World
Application(s) Root Path: C:/Users/VegaO/mtw

Press “Create” to create the selected application(s).

< Back Create Close

Note: The actual application names available might vary.

Type a name for your application or leave the default name. Do not use spaces in the application name. Also,
do not use common illegal characters, such as:

*."m Y/ N T sy =y
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2.4 Step 4: Create application

Click Create to start creating the application. The tool displays various messages.

Select Application - Project Creator 2.0 — [} X

Settings  Help

Application(s) Root Path: | C/Users/VegaO/mtw/example_3.0 Browse...
Target IDE: Eclipse IDE for ModusToolbox™
Search. Browse... 72 B2 2] [#  This code example demonstrates simple UART communication by printing
— a "Hello World" message on a terminal and blinks an LED using a Timer
Template Application New Application Name resource using PSoC™ 6 MCU.
Bluetooth®
« Getting Started For more details, see the README on GitHub

Dual-CPU Empty PSoC6 App
Empty PS0C6 App
Hello World Hello_World
Security App
Switching Power Modes

Graphics

Machine Learning

Manufacturing

Peripherals

Sensing

Voice

Summary: Q
BSP: CYSCKIT-062-WIFI-BT

Template Application(s): Hello World

Application(s) Root Path: C:/Users/VegaO/mtw/example_3.0

Press “Create” to create the selected application(s).

< Back Create Close

@

When the process completes, a message states that the application was created, and the Project Creator tool
closes automatically. For more information, refer to the Project Creator user guide.

After several moments, the application opens in the Eclipse IDE with the Hello_World project in the Project
Explorer, with various files and directories. The README.md file opens in the file viewer/code editor where you
can read the text.

E hw - Hello_World/README.md - Eclipse IDE for ModusToolbox™ - O x
File Edit Navigate Search Project Run Window Help
blif 2 | B~ r@igvOrQuvi®@sy il EEARS ' T v oo o |
& Dob 1@ 2 Do ;. O [¥ READMEmd S0 Zoutinex ~ O
. v 8 e B8
. A
d Project PSoC™ 6 MCU: Hello world ~ 1. PSoCédrade; 6
o h2. Requirements|
Explorer h2. Supported to
This code example demonstrates simple UART communication by h2. Supported kit]
printing the "Hello world" message on a terminal and blinks an LED h2. Hardware set
using a timer resource in PSoC™ h2. Software setu
. . . 1 1 h2. Using the cod|
View this README on GitHub, FIIZVIGZVGI’/ 2. Operstion
. . Code Editor h2. Debugging
Provide feedback on this code exal « h2. Design and in

h3. Resources

Requirements h2. Related resou|

h2. Other resourc|
h2. Document hi

* ModusToolbox&tracs, sunware v2.2 or later (tested with v2.3)

EQuic.. ®-Vari.. @ Exp.. % Brea. — O * Board support package (BSP) minimum required version:
200
Eclipse IDE for A~ . Progra_mmlng language: C
P - + Associated parts: All PSoC&trade: 6 MCU parts v
ModusToolbox
< >

~ SEI Markdown Source | Preview < >
& New Application B Console 2 (2] Problems =g Progress 0 Memory (& Terminal % pfE| MBIy = 0O
= Import Existing Application In-Place ModusToolbox™ Console

& Search Online for Code Examples Log file(s) for this session are stored at: C:\Users\VegaO\AppData\local\Temp\lLogs105211°

Opening project creator from C:/Users/VegaO/ModusToolbox/tools_3.8/project-creator/projec
Import scheduled. As projects are imported, they will appear in Project Explorer.
& Training Material Log file(s) for Project Creator are stored at: C:\Users\VegaO\mtw 3.@\hw\project-creator

& Search Online for Libraries and BSPs

% Refresh Quick Panel
» Project

b Launches
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3 Add/modify application code

Code example applications work as they are, and there is no need to add or modify code in order to build or
program them. However, if you want to update and change the application to do something else, open the
appropriate file in the code editor.

Double-click the main.c file to open it.

Eyp 2 4D HER FP T 8  [d mainc 53 = B8
15V §| 0o oy Opress et Ll MebtIiy LA
v Hello_World
B
35, Binaries #include “cyhal.h”
) Includes #include "cybsp.h”
= bsps #include "cy retarget io.h”
= build
(= deps N T—
(= images * Macros
/* LED blink timer clock value in Hz =/
> . #define LED_BLINK_TIMER_CLOCK_HZ (1e000)
Makefile * LED blink timer period value */

README.md #define LED_BLINK_TIMER_PERIOD (9999)
=% mtb_shared

* Function Pr

void timer_init(void);
static void isr_timer(void *callback_arg, cyhal_timer_event_t event);

As you type into the file, an asterisk (*) will appear in the file’s tab to indicate changes were made. The
Save/Save As commands will also become available to select.
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4 View device resources

To view peripherals, pins, clocks, etc., open the Device Configurator. Right-click on the project folder and select
ModusToolbox™ > Device Configurator <version>.

hw - Hello_World/main.c - Eclipse IDE for ModusToolbox™
File Edit Source Refactor Mavigate Search Project Run Window Help
Hmihe | @&~ & - [m: B [ER| S -0-G-® -

[{ Projec... 2 4% Debug ifli Regist.. B, Perip.. = B [g mainc

B Gj‘) 7 8 so agrees to indemnify Cypress against all liabi
~ 125 Hello_World
i, Binarie New > kinclude "cyhal.h”
&) Include i include "cybsp.h"
= bsps include "cy_retarget_ic.h”
&= build Open in New Window
(& deps Shaw In Alt+Shift+W >
= :_’23955 & ModusToolbox™ > Tools
ibs
% main.c Show in Local Terminal > BSP Assistant 1.0
|2 LICENS [ Copy ChrleC Device Firmware Update Host Tool 1.60
L& Makefi Paste Ctri+V Library Manager 2.0
READM Jomgiei Dl T Bt
15 mtb_share clete st .
Source 7 CAPSENSE™ Configurator 5.0
—_— CAPSENSE™ Tuner 5.0
rme 2 Device Configurator 4.0 I

QSPI Cenfigurator 4.0

i Import...

Segment LCD Configurator 1.50 (new configurator)
E. it

The Device Configurator provides access to the BSP resources and settings. Each enabled resource contains
one or more links to the related APl documentation. There are also buttons to open other configurators for
CAPSENSE™, QSPI, Smart 1/0, etc. For more information, refer to the Device Configurator guide, which is also
available by selecting View Help from the tool’s Help menu.

C:fUsers/VegaO/mtw_3.0/hw/Hello_World/libs/TARGET_CY8CKIT-062-WIFI-BT/COMPONENT_BSP_DESIGN_MODUS/design.modus - Device Configurator 4.0 - O x
File Edit View Help
CY8C6247BZI-D54 CYW4343WKUBG CSD (CapSense, etc.) 0 (CYBSP_CSD) - Parameters g %
Peripherals Pins Analog-Routing System Peripheral-Clocks DMA Enter filter text.. g B8
Enter filter text.. T B £ BT | Name Value A
Resource Name(s) Personality v Peripheral Documentation
Analog () Configuration Help Open CSD Documentation
Communication ~ Inputs
Digital @ Clock & | @ 8bit Divider 3 clk (CYBSP_CSD_CLK_DIV, CYBSP_CS_CLK_DIV) [USED]
v System v CapSense
CSD (CapSense, etc.) 0 CYBSP_CSD CsD-2.0 (@) Enable CapSense
[ LCD Direct Drive 0 cd_0_drive_0 @ Target CPU core Cortex M4
[ Multi-Counter Watchdog Timer (MCWDT) 0|srss_0_mcwdt 0 v External Tools
[ Multi-Counter Watchdog Timer (MCWDT) 1|srss_0_mcwdt_1 () CapSense Configurator | Launch CapSense Configurator
[ Real Time Clack (RTC) srss_0_rtc 0
(2) CapSense Tuner Launch CapSense Tuner
v CSDADC
(2 Enable CSDADC O
v CSDIDAC
() Enable CSDIDAC O

v CapSense Capacitors

<

>
CSD (CapSense, etc.) 0 (CYBSP_CSD) - Parameters Code Preview
Notice List & X
Qocros 1 oWamings | [Z) 17ask (@6 nfos
Fix Description - Location

Ready

Note: The Device Configurator cannot be used to open Library Configurators, such as Bluetooth® and
USB.
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Infineon

Build the Application

Building the application is not specifically required, because building will be performed as part of the
programming and debugging process. However, if you are running the Eclipse IDE without any hardware
attached, you may wish to build your application to ensure all the code is correct.

In the Project Explorer, click on the Hello_World project. In the Quick Panel, click the Build Application link.
Build information will display in the Console pane.

€ >
125 Hello_World

<

Q hw - Helle_World/main.c - Eclipse IDE for ModusToolbox™ - m] *
File Edit Source Refactor Mavigate Search Project Run Window Help
[l 2 | ® -8~ &iQ: 2R S~ 0~%~i® & ! M1 R s
Q |
EoP 22 %D MR ZP = 8  [dmanc R} = B J=outine 5z = O
2%V & #include "cyhal.h” ~REABRY e
= .
= Helu_WorId #include "cybsp.h” £
5, Dinanes #include "cy_retarget_io.h" H
[l :dudes W cyhalh ~
- bsplil e 0 cybsph
=] dw - Macros 2 cy_retarget io.
(= deps # LED_BLINKTIN
(= images f* LED blink timer clock walue in Hz # LED_BLINK_TIV
(= libs #define LED_BLINK TIMER_CLOCK_HZ (16600) - L o
S — — = = ++  timer_init(void]
[« main.c s .
= LICENSE /* LED blink timer period value */ ++ isr_timer(veid®,
= #define LED_BLINK_TIMER_PERIOD (9999) @ timer_interrupt
@ Makefile - - - : -
&) README.md @  led_blink_activ
cnth N dlm @ uart_read_value
= mtb _share - v @ led_blink_timer ¥

<

Q. @-V.. & E. 9%B. = O & Console i3 [8 Problems [J Memory & Terminal 34§ |5 CB EE x| MB-N-=08
CDT Build Console [Hello_Waorld]
ZEFU. LaDIE [ eXIvLELEEs | 6 T "
H ~ | .data | exesep22e0 | 1600 |
EC[IPSE IDE for | .ey_sharedmem | exesee2920 | 8 |
™ | .noinit | exeses2928 | 224 |
ModusToolbox | .bss | exesepzaes | 1212 |
| .heap | exeseszecs | 1@38456 |
B Start
~ Hello World (TARGET_APP_CY8CKIT-{
Total Internal Flash (Available) 2097152
ﬁEuilcl Application Total Internal Flash (Utilized) 54872
o Clean Application
= INFO message(s) = ======
» Launches
Eatoot 16:48:59 Build Finished. ® errors, & warnings. (tock 47s.73Bms)
» BSP Configurators (TARGET_APP_CY8
v v

< >

If you have the Hello_World project selected, you can also select Build Project from the Project menu or from
the right-click menu. The Eclipse menus change based on what you have selected in the Project Explorer.

Hmiie

[ ®~-& - @i

v 25 Hello_World
4% Binaries

E hw - Hello_Waerld/main.c - Eclipse IDE for MedysToolbox ™

File Edit Source Refactor Navigate Searc un Window Help

[ Projec... 52 # Debug iflf Regist.. . Perip.. @ Build All

DOpen Project

Close Project

Ctrl+B

= Build Configurations >
| Build Project |

Build Working Set >
g L”“”'jes Clean..
sps

[ hu?ld Build Autematically

= deps & ModusToolbox™ bl

(= images

= libs C/C++ Index >

»

[ maine Properie
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6 Program the Device

There are several different "Launch Configurations" for programming and debugging the various development
kits and starter applications within the Eclipse IDE. These Launch Configurations provide details about how to
configure the application. This section provides a brief walkthrough for programming this example. For more
details about other Launch Configurations and settings, refer to the Eclipse IDE for ModusToolbox™ user guide,
"Program and Debug" chapter.

6.1 Connect the Kit

Follow the instructions provided with the CYS8CKIT-062-WIFI-BT kit to connect it to the PC with the USB cable.

Note: This kit’s firmware may be set to KitProg2. To use this kit with the ModusToolbox™ software, you
must upgrade the firmware to KitProg3. Refer to the KitProg3 user guide for more details.

6.2 Program

In the Project Explorer, select the Hello_World application. Then, in the Quick Panel, click the Hello_World
Program (KitProg3_MiniProg4) link.

uic (9= Varia  Expre.. % Brea
&= Quick Variab... % Expi ®s Break. =8

Eclipse IDE for -
ModusToolbox™
» Start
+ Hello_ World
~ Launches
£ Hello_World Debug (JLink)
£ Hello_World Debug (KitProg3_MiniProg4)
O Hello_World Program (JLink)
| © Hello_World Program (KitProg3_MiniProg4) |

A Generate Launches for Hello_World

» Tools

+ BSP Configurators (<bsp-name>) v
< >

If needed, the IDE builds the application and messages display in the Console. If the build is successful, device
programming starts immediately. If there are build errors, then error messages will indicate as such. When
complete, the LED will start blinking.

h

00
00
00
o0
on
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7 Debug the program

As mentioned under the Program the device section in this document, there are many different Launch
Configurations for different kits and applications. This section provides a brief walkthrough for debugging this
example. For more details about other Launch Configurations and settings, refer to the Eclipse IDE for
ModusToolbox™ user guide, "Program and Debug" chapter.

In the Project Explorer, select the Hello_World application. Then, in the Quick Panel, click the Hello_World
Debug (KitProg3) link under Launches.

& Quick.. ®-Variab.. & Expre.. % Break. =~ O

Eclipse IDE for -
ModusToolbox™

» Start

» Hello_World

~ Launches

% Hello_World Debug (Link)

H? Hello_World Debug (KitProg3_MiniProg4) I

© Hello_World Program (JLink)

© Hello_World Program (KitProg3_MiniProg4)
A Generate Launches for Hel o_World
» Tools

» BSP Configurators (<bsp-name>) v
< >

If needed, the IDE builds the application and messages display in the Console. If the build is successful, the IDE
switches to debug mode automatically. If there are build errors, then error messages will indicate as such.

[ hw - Hello_World/main.c - Eclipse IDE for MedusToolbex™ - m] *

Eile Edit Source Refactor [Mavigate Search Project Run  Windoew Help

Hmild | B -Q-Ric o ® 3 =0 | &ite~ O~ Q~i® ¢~ PP e
Q ®|
fPr. dsDe. 32 WHRe. F Pe. = O [w] READMEmd [T] 0x1600400c [€] main.c 32 = 8 BEou. i = 0
B k| § I =
« [E] Hello_Warld Debug (KitProg3_MiniProgd) [GD ey_rslt_t result; *

v i mtb-example-psocé-hello-world.elf

= main{) at main.c:37 0x 10002338
»| openocd.exe
p| arm-none-eabi-gdb

w @ Thread #1 1 (Name: Current Execution)

/* Initialize the device and board peripherals */
result = cybsp_init()};

/* Board init failed. Stop program execution */
if (result != CY_RSLT_SUCCESS)

CY_ASSERT(8);

< /* Enable global interrupts =/ @ led blink acti
__enable_irq(); @ uart_read_val
B Qui.. (9= Vari. @7 Ex. 9gBre. = O @  led_blink_tim

/* Initialize retarget-io to use the debug UART port */
result = cy retarget io init(CYBSP DEBUG UART TX, CYBSP DEBUG UART F ¥

]
= cy_retarget_ic A
# LEDBLINK_TI
# LEDBLINK_TI
++  timer_init(voi
Hs isr_timer(voic
® timer_interry|

<_> Tain(voi.d'] 3 | v

- < > < >
Eclipse IDE for
ModusToolbox™ B Console 52 [*] Problems  [] Memory =] Mews [} ETEN SRl R =
Hello_World Debug (KitProg3_MiniProg4) [GDB OpenQCD Debugging]
e (25) d1 (/64): @xFEFFFFFFGF7DF7FD a
(26) d2 (/64): @xFDCFFCFF7F2BEBBE
» Hello_World (CYS8CKIT-062-WIFI-BT) (27) d3 (/64): BxTIFFFF7BFEDFFI7BF
. ) (28) d4 (/64): @xF7ADF7FDFFBFFBDE
~ Llaunches (29) d5 (/64): @xFFFDEFFDFFBAF7FS
N i (3@) d6 (/64): @xFFBFFBF3FFF7F3SE
3§ Hello_World Debug (ILink) (31) d7 (/64): @x7DFFEEZFFF7DFBFY
45 Hello World Debug (KitProg3_MiniProg4) (32) d8 (/64): @xDBFFFDEFFEEDBSEF
(33) d9 (/64): @xEFEFFDFFFFSFEF7F
© Hello_World Program (JLink) (34) d1@ (/64): BxFDFFD76CFFEFBFFB
e . . (35) d11 (/64): @xFDEBFDSFAFF76BD7
Q Hello_World Pregram (KitProg3_MiniProg4) (369 d12 (/64): BxFBFDFFEFFE7GFFBT
&, Generate Launches for Hello_World (37) d13 (/e4): ex7677BEFEFFEBFFEF
(38) d14 (/64): BxFFBFBCBEFTAEAFFY
b e 5 (39) d15 (/64): @x7DIFFBSEEFFDF7F7
(4@) fpscr (/32): Gxe00EEG00
H *
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IMPORTANT NOTICE

The information given in this document shall in no
event be regarded as a guarantee of conditions or
characteristics ("Beschaffenheitsgarantie") .

With respect to any examples, hints or any typical
values stated herein and/or any information
regarding the application of the product, Infineon
Technologies hereby disclaims any and all
warranties and liabilities of any kind, including
without limitation warranties of non-infringement of
intellectual property rights of any third party.

In addition, any information given in this document
is subject to customer’s compliance with its
obligations stated in this document and any
applicable legal requirements, norms and standards
concerning customer’s products and any use of the
product of Infineon Technologies in customer’s
applications.

The data contained in this document is exclusively
intended for technically trained staff. It is the
responsibility of customer’s technical departments
to evaluate the suitability of the product for the
intended application and the completeness of the
product information given in this document with
respect to such application.

For further information on the product, technology.
delivery terms and conditions and prices please
contact your nearest Infineon Technologies office
(www.infineon.com).

WARNINGS

Due to technical requirements products may contain
dangerous substances. For information on the types
in question please contact your nearest Infineon
Technologies office.

Except as otherwise explicitly approved by Infineon
Technologies in a written document signed by
authorized representatives of Infineon
Technologies, Infineon Technologies’ products may
not be used in any applications where a failure of the
product or any consequences of the use thereof can
reasonably be expected to result in personal injury.
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